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What Is Print Manager?
Print Manager handles print requests for your printer. Whenever you print a document from a Windows 
application, the application passes all the printer and font information about the file to Print Manager. 
Print Manager handles the request in the background while you continue working.
You can always find out about the print requests Print Manager is handling by starting the Print Manager
application from the Main group of Program Manager. The Print Manager window looks like this:

As you send files to Print Manager, Print Manager forms a print queue--a list indicating the files currently
printing and the files waiting to be printed.
NOTE: Print Manager is not used for installing a printer to work with Windows. You install printers from 
Control Panel in the Program Manager Main group.

Related Procedure



Concept
The Print Manager Window

Procedure
Installing New Printers



The Print Manager Window
The Print Manager window lets you view important information about the printer activity and gives you 
buttons that pause or cancel items in the queue.
The standard elements of the Print Manager window are:



command buttons
Let you pause and resume print jobs or delete one or more print jobs.



message box
Shows you details about current printing.

In this case, Print Manager displays network information about the printer. The information includes the 
name of the printer, its location (local or network), its port, and that it's active or printing.



file information line
Information specific to each file in a print queue. The information can include these details:

The file's position in the queue or a printer icon if the file is printing.
The title of the print job assigned by the application (if your network software supports this).
What percentage of the file has printed so far.
The size of the file in kilobytes (if the Print File Size command on the View menu is selected).
The time and date you sent the file to Print Manager (if the Time/Date Sent command on the View

menu is selected).
If you are connected to a network printer, the printer queue information line shows the network server 
connection. Any detailed information the network can provide appears in the message box at the upper-
right corner of the Print Manager window. Networks can provide varying degrees of detailed information.



local queue
Lists the files that you directed to any active printer connected to your computer. The computer and 
printers are connected locally by a cable.
When Print Manager starts printing on a local printer, its icon appears at the bottom of your screen. If 
you restore the icon to a window, you see the print queue for any active printer connected to your 
computer. You can use the Print Manager window to check the status of files in the print queue or to 
interrupt or cancel a print job.



network queue
Lists the files on the network server if you are using a network printer.
The network queue is generally managed by a network print manager, which is separate from the 
Microsoft Windows Print Manager. To print over a network queue, you should install the Windows 
network driver for your network, start the network before you start Windows, and make a network printer 
connection.
When running with a network printer, Print Manager tracks the progress of your print files on the network
print manager. Generally, print files are passed directly to the network queue, where they are spooled to 
the printer.
To view the status of your print job, you must start Print Manager from the Program Manager group. The 
Print Manager icon doesn't appear at the bottom of your screen when you print to a network queue.



Printing from Windows Applications
When you print from a Windows application, the application creates a print file and sends it to Print 
Manager. From this point on, Print Manager manages the printing of the file. 
The appearance of your printed copy depends on several things, including:

The fonts your application supports.
The fonts and formats you use.
The fonts and formats your printer can use.

Printers differ in their ability to use fonts, graphics, spacing, alignment, and character formats. The 
appearance of printed copy can vary from printer to printer. 
Some applications attempt to display files on the screen as they will look when printed. You might need 
to experiment with your printer to get the results you want.



Printing from Non-Windows Applications
Non-Windows applications do not use Print Manager or Windows printer drivers. You must set up 
printers for each non-Windows application and wait while the files print. Even if you start the application 
from Windows, it prints as though you started it from MS-DOS.
If you want to use Print Manager or the Windows printer drivers, you must transfer the information you 
want to print into a Windows application.



Printing on a Network
Print Manager has a number of options for printing on a network. You can:

View all the files in a network printer’s queue, instead of just your files.
View another network queue that you are not currently connected to.
Bypass Print Manager and print directly to the network.
Ignore the status of a network printer queue.

NOTE: Some network options might not be available on your network. The support for network options 
depends on the capabilities of your network software and the support provided with your Windows 
network driver.

Related Procedures



Procedures
Bypassing Print Manager
Ignoring the Network Status
Viewing Other Network Queues
Viewing the Entire Network Queue











Low Priority Command

Gives low priority to printing.
When you choose this command, less of the computer's processor time is devoted to printing and more 
to running applications. As a result, this command slows printing speed but limits the slowing effect on 
applications during printing.

Related Procedure



Medium Priority Command

Gives medium priority to printing.
When you choose this command, the computer's processor time is divided about equally between 
printing and running applications. As a result, printing speed and the slowing effect on applications are 
both moderate.

Related Procedure



High Priority Command

Gives high priority to printing.
When you choose this command, more of the computer's processor time is devoted to printing and less 
to running applications. As a result, this command maximizes printing speed but increases the slowing 
effect on other applications during printing.

Related Procedure



Alert Always Command

Always alerts you by displaying a Print Manager message immediately.
Occasionally, Print Manager needs to display a message when something goes wrong with printing or 
when some action is required of you. For example, if your printer is set up for manual paper feed, Print 
Manager will request that you feed in a new sheet of paper. This command does not control the display 
of system-level messages such as when the printer is offline.

Related Procedure



Flash if Inactive Command

Alerts you with a the system default sound and flashing Print Manager icon or title bar if Print Manager 
has a message and is inactive.
Occasionally, Print Manager needs to display a message when something goes wrong with printing or 
when some action is required of you. For example, if your printer is set up for manual paper feed, Print 
Manager will request that you feed in a new sheet of paper. This command does not control the display 
of system-level messages such as when the printer is offline.
If you choose this command, your computer makes the sound once, and the Print Manager icon or title 
bar flashes when the Print Manager window is inactive. Flashing continues until you make the window 
active or restore the icon to a window. Then the message is displayed.

Related Procedures



Procedures
Changing System Sounds
Displaying Print Manager Messages



Ignore if Inactive Command

Ignores messages if the Print Manager window is inactive or minimized to an icon.
Occasionally, Print Manager needs to display a message when something goes wrong with printing or 
when some action is required of you. For example, if your printer is set up for manual paper feed, Print 
Manager will request that you feed in a new sheet of paper. This command does not control the display 
of system-level messages such as when the printer is offline.
If you choose this command, Print Manager ignores messages until you make the Print Manager 
window active or restore the icon to a window. Then the message is displayed.

Related Procedure



Network Command

Controls Print Manager's interaction with a network printer.
Clear the Update Network Display check box to have Print Manager ignore the status of network 
queues. Ignoring the status of the network might reduce network traffic.
Select the Print Net Jobs Direct option to print without Print Manager. Printing directly to networks is 
generally faster than printing with Print Manager. Print Manager can report on the status of the network 
print queue whether or not you select the Print Net Jobs Direct option.
This command is available with only some types of network software.

Related Procedures



Procedures
Bypassing Print Manager
Ignoring the Network Status



Exit Command

Exits the Print Manager window.
Choosing this command cancels printing of any files you have in a queue. Print Manager warns you of 
this before canceling the printing. If you do not choose OK, Print Manager will remain running, and the 
files will continue to print.
CAUTION: If you delete a file currently printing in graphics mode, you might need to reset your printer to
ensure that the printer's buffer is clear. (Turn it off and back on or select the Reset option, if available. It 
is most important to do this with Laser-type printers.)

Related Procedures



Procedures
Canceling Printing
Exiting from Print Manger



Time/Date Sent Command

Turns on or off the display of the time and date files were sent to the printer.
Related Procedure



Print File Size Command

Turns on or off the display of the size of files sent to the printer.
File sizes are measured in kilobytes (kb).

Related Procedure



Update Net Queues Command

Updates the status of the network queue.
Print Manager automatically updates the status of a network queue periodically. This command updates 
the network print queue immediately.
This command is available with only some types of network software.

Related Procedure



Selected Net Queue Command

Shows the entire queue for a selected network printer.
Unless you choose this command, you cannot view all the files sent to a network printer. Ordinarily, 
when you print a file on a network printer, Print Manager displays a print queue that shows only the files 
you have sent to that printer.
The queue list is not updated until you choose this command again.
This command is available with only some types of network software.

Related Procedure



Other Net Queue Command

Displays the queue for a network printer you are not connected to.
Unless you choose this command, you cannot view the files sent to a network printer to which you are 
not connected. Ordinarily, you can view only those files sent to a printer to which you are connected.
The queue list is not updated until you choose this command again.
This command is available with only some types of network software.

Related Procedure
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Turning Print Manager On or Off
Print Manager controls printing in the background while you continue to work with your applications in 
the foreground. However, if you want, you can print from a Windows application without using Print 
Manager. Your application then prints directly to your local printer or to the network printer

To turn Print Manager on or off:
1 Choose the Printers icon from the Control Panel window.
2 Select the Use Print Manager check box to turn Print Manager on.

Or clear the check box to turn Print Manager off.
3 Click OK.
NOTE: Keep in mind that if you print without Print Manager, you cannot work with your computer until 
the print file is completely delivered to the network or your local printer. Printing without Print Manager 
also prevents you from receiving a report on the status of the local or network print queue. If, however, 
you merely bypass Print Manager instead of turning it off, you can still receive reports on network queue 
status and manage your print files on a local printer. To bypass Print Manager, you choose the Print Net 
Jobs Direct option with Print Manager's Network command.

Keyboard Procedure



Looking at the Print Queue
Print Manager displays two types of queues: local and network.

To look at the print queue:
Choose the Print Manager icon from the lower-left corner of the desktop if you are printing on a 

local printer.
Or choose Print Manager from Program Manager's Main Group window if you are printing on a 
network printer.
Print Manager can display both local and network print queues at the same time. If you have more 
than one printer connected to your machine, you see multiple printer queue information lines and you 
might see a print queue for each printer. If a file has been printed or is printing, the queue will list an 
information line for the file.

Related Procedures
Keyboard Procedure



Procedures
Restoring a Window or Icon to Its Previous Size
Starting Applications



Changing the Printing Speed
You can specify the rate at which information is transferred from Print Manager to the printer ports by 
using the Low Priority, Medium Priority, and High Priority commands on the Options menu.

To print files slowly:
Choose Low Priority from the Options menu.

This setting allows more of the computer's processor time to run applications, limiting the slowing 
effect on other applications during printing.

To print files somewhat faster:
Choose Medium Priority from the Options menu.

This setting specifies that your computer's processor time be shared equally between Print Manager 
and other applications, causing a moderate slowing effect on other applications during printing.

To print files much faster:
Choose High Priority from the Options menu.

This setting allows more of your computer's processor time for Print Manger, causing a high slowing 
effect on other applications during printing.

Keyboard Procedure



Changing the Order of the Queue
In local print queues, you can change the position of a file that has not started printing. If you are printing
to a network printer, you cannot change the position of files in the queue.

To change the position of a file:
1 Drag the file up or down in the print queue.
2 Release the mouse button to position the file in the queue.

Keyboard Procedure



Displaying the Time/Date and File Size
Using two commands on the View menu, you can turn on or off the display of the time and date you sent
a file to Print Manger and the size of the file in kilobytes.

To turn the time-and-date or file-size display on or off:
Choose Time/Date Sent or Print File Size from the View menu.
Keyboard Procedure



Displaying Print Manager Messages
Occasionally, Print Manager needs to display a message. For example, if your printer is set up for 
manual paper feed, Print Manager will request that you feed in a new sheet of paper. The Options menu 
provides three commands for controlling the way Print Manager handles this type of message.

To set display options for Print Manager messages:
Choose one of the commands from the Options menu.

These commands do not control the display of system-level messages such as when the printer is 
offline.

Use this command To
Alert Always Display a message immediately.
Flash if Inactive Report incoming messages if the window is inactive.

Your computer makes the system default sound once, and the Print Manager
icon or title bar flashes. Flashing continues until you make the window active 
or restore the icon to a window. Then the message is displayed.

Ignore if Inactive Ignore messages if the Print Manager window is inactive or minimized to an 
icon.
To see messages, you must make the Print Manager window active or 
restore the icon to a window.

Related Procedure
Keyboard Procedure



Pausing and Resuming Printing
Using buttons in the Print Manager window, you can interrupt the printing of a print queue.

To interrupt printing temporarily:
1 Select the information line for a file on a network queue or for the printer on a local queue.
2 Click the Pause button.

The selected information line changes to indicate that printing has paused.
Some networks allow you to pause an individual print file. However, your ability to interrupt a network 
queue depends on the specific features the network supports.

To resume printing:
1 Select the information line for a file on a network queue or for the printer on a local queue.
2 Click the Resume button.

The selected information line changes to indicate that printing has resumed.
Related Procedure
Keyboard Procedure



Canceling Printing

To delete a file from a print queue:
1 Select the information line for the file.
2 Click the Delete button.
3 Click OK to confirm the cancellation.

You may not be able to delete a file from a network print queue if your network software does not 
support this feature.

To delete all your files from all print queues:
1 Choose Exit from the Options menu.
2 Click OK to confirm the cancellation.

If you do not click OK, Print Manager will remain running, and the files will continue to print.

CAUTION: If you delete a file currently printing in graphics mode, you might need to reset your printer to
ensure that the printer's buffer is clear. (Turn it off and back on again or select the Reset option, if 
available. It is most important to do this with Laser-type printers.)

Related Procedure
Keyboard Procedure



Printing to a File
Sometimes, you might want to format a spreadsheet, report, or other document and print it to a file 
rather than to a printer.
Click        for examples of why you might want to print to a file.

To print to a file:
1 Choose Control Panel from the Main Group window or enlarge the Control Panel icon.
2 Choose the Printers icon.
3 In the Installed Printers box, select the name of the printer you eventually want to print the file to.
4 Choose Configure.
5 In the Ports box, select FILE as your port.
6 Choose Setup and make sure your print options are set properly.
7 Return to the Control Panel window.
8 Return to your application and follow the instructions to finish printing your document to a file.

While you are connected to a file, Print Manager prompts you for the filename each time you print 
from an application. In addition to the filename, you can also specify a drive and directory in which 
you want to store the file.

NOTE: In some applications, you can print to a file by using the application's Printer Setup command. 
This method might be faster than using Control Panel.

Related Procedures
Keyboard Procedure



Procedures
Restoring a Window or Icon to Its Previous Size
Starting Applications



example
You might print to a file to:

Merge text or graphics into another document.
Print at a later time or at a different location.



Quitting from Print Manager
If running as an icon, Print Manager terminates automatically (and frees the memory it was using) when 
it finishes printing. If the Print Manager window is open, it does not terminate automatically.

To exit from the Print Manger window:
Choose Exit from the Options menu.

If filenames remain in the print queue, a dialog box appears, asking if you want to cancel the printing 
of these files. If you click OK, Print Manager does not print the remaining files.

Keyboard Procedure



Updating the Network Status Manually
With some types of network software, when Print Manager is running as a window, it automatically 
updates the network queue status periodically or when a change on the network has occurred. You can 
also update the status manually.

To update the network queue status manually:
Choose Update Net Queues from the View menu.
Keyboard Procedure



Ignoring the Network Status
Print Manager does not update the status of the network queue when it is running as an icon. However, 
when you restore the icon to a window, Print Manager begins updating the queue periodically. If you are 
concerned about network traffic or don't need to view the network status, you can specify that Print 
Manager ignore the status of a network queue, even when it is running as a window.

To specify that Print Manager ignore the status of a network queue:
1 Choose Network from the Options menu.
2 Clear the Update Network Display check box.
3 Click OK.

The network print queue will be treated as a local print queue when this option is turned off.
Keyboard Procedure



Viewing the Entire Network Queue
Normally, when you print a file on a network printer, Print Manager displays a print queue that shows 
only the files you have sent to that printer. With some types of network software, however, you can see 
all the files sent to that printer, no matter who sent them.

To view the entire queue for a network printer that you are connected to:
1 Select the information line for the network printer.
2 Choose Selected Net Queue from the View menu.

Print Manger displays the entire queue for the selected printer.
The queue list is not updated until you choose Selected Net Queue again.

3 Choose Close when you're finished.
Related Procedure
Keyboard Procedure



Viewing Other Network Queues
With some types of network software, Print Manager lets you view queues for network printers that you 
are not connected to. This allows you to look at how many files are in the queues for different network 
printers before deciding which one you want to print to. However, you must use Control Panel to connect
to another network printer before you can print to it.

To view the print queue for a printer you are not connected to:
1 Choose Other Net Queue from the View menu.
2 Type the pathname of the network queue in the Network Queue box.
3 Choose View.

Print Manager displays status information for the queue in the box above the Network Queue box.
The queue list is not updated until you choose Other Net Queue again.
See your network software documentation for information on how to enter the network pathname.

4 Type the name of another queue that you want to view.
Or choose Close when you're finished.

Related Procedures
Keyboard Procedure



Procedures
Connecting to Network Printers
Viewing the Entire Network Queue



Bypassing Print Manager
With some types of network software, you might find that your applications print faster when you bypass 
Print Manager and send files directly to the network. Routing the file through Print Manager adds an 
extra step that can delay printing over a network. You can turn off Print Manager with Control Panel, but 
merely bypassing it lets you receive reports on network queue status and manage your print files on a 
local printer.

To bypass Print Manager:
1 Open the Print Manager window.
2 Choose Network from the Options menu.
3 Select the Print Net Jobs Direct option.
4 Click OK.

Related Procedure
Keyboard Procedure
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Keyboard: Turning Print Manager On or Off
To turn Print Manager on or off:
1 Choose the Printers icon from the Control Panel window.
2 Press ALT+U.
3 Press the SPACEBAR to turn Use Print Manager on or off.
4 Press ENTER.

Mouse Procedure



Keyboard: Looking at the Print Queue
To look at the print queue:

Restore the Print Manager icon.
Or start Print Manager from the Main Group window.

Related Procedures
Mouse Procedure



Procedures
Restoring a Window or Icon to Its Previous Size
Starting Applications



Keyboard: Changing the Printing Speed
To print files slowly:
1 Press ALT and then O.
2 Press L.

To print files at a moderate speed:
1 Press ALT and then O.
2 Press M.

To print files quickly:
1 Press ALT and then O.
2 Press H.

Mouse Procedure



Keyboard: Changing the Order of the Queue
To change the position of a file:
1 Use the UP ARROW or DOWN ARROW key to select the file.
2 Hold down CTRL and press the UP ARROW or DOWN ARROW key.
3 Release CTRL and the ARROW key.

Mouse Procedure



Keyboard: Displaying the Time/Date and File Size
To turn the time-and-date or file-size display on or off:
1 Press ALT and then V.
2 Press T (Time/Date Sent) or P (Print File Size).

Mouse Procedure



Keyboard: Displaying Print Manager Messages
To set display options for Print Manager messages:
1 Press ALT and then O.
2 Press A (Alert Always), F (Flash if Inactive), or I (Ignore if Inactive).

Related Procedure
Mouse Procedure



Keyboard: Pausing and Resuming Printing
To interrupt printing temporarily:
1 Use the UP ARROW or DOWN ARROW key to select the information line for a file on a network queue or 

for the printer on a local queue.
2 Press ALT+P.

To resume printing:
1 Use the UP ARROW or DOWN ARROW key to select the information line for a file on a network queue or 

for the printer on a local queue.
2 Press ALT+R.

Related Procedure
Mouse Procedure



Keyboard: Canceling Printing
To delete a file from a print queue:
1 Use the UP ARROW or DOWN ARROW key to select the information line for the file.
2 Press ALT+D.
3 Press ENTER to confirm the cancellation.

To delete all your files from all print queues:
1 Press ALT and then O.
2 Press X.
3 Press ENTER to confirm the cancellation.

Related Procedure
Mouse Procedure



Keyboard: Printing to a File
To print to a file:
1 Choose Control Panel from the Main Group window or enlarge the Control Panel icon.
2 Use the ARROW keys to select the Printers icon and press ENTER.
3 In the Installed Printers box, use the UP ARROW or DOWN ARROW key to select the name of the printer 

you eventually want to print the file to.
4 Press ALT+C.
5 Use the UP ARROW or DOWN ARROW key to select FILE as your port.
6 Press ALT+S and make sure your print options are set properly.
7 Return to the Control Panel window.
8 Press ALT+ESC until you return to your application.
9 Follow the instructions to finish printing your document to a file.

Related Procedures
Mouse Procedure



Procedures
Restoring a Window or Icon to Its Previous Size
Starting Applications



Keyboard: Quitting from Print Manager
To exit from the Print Manger window:
1 Press ALT and then O.
2 Press X.

Mouse Procedure



Keyboard: Updating the Network Status Manually
To update the network queue status manually:
1 Press ALT and then V.
2 Press U.

Mouse Procedure



Keyboard: Ignoring the Network Status
To have Print Manager ignore the status of a network queue:
1 Press ALT and then O.
2 Press N.
3 Press the SPACEBAR to clear the Update Network Display check box.
4 Press ENTER.

Mouse Procedure



Keyboard: Viewing the Entire Network Queue
To view the entire queue for a network printer:
1 Use the UP ARROW or DOWN ARROW key to select the information line for the network printer.
2 Press ALT and then V.
3 Press S.
4 Press ENTER when you're finished.

Related Procedure
Mouse Procedure



Keyboard: Viewing Other Network Queues
To view the print queue for a printer you are not connected to:
1 Press ALT and then V.
2 Press O.
3 Type the pathname of the network queue in the Network Queue box.
4 Press ALT+V.
5 Type the name of another queue that you want to view.

Or press ESC when you're finished.
Related Procedures
Mouse Procedure



Procedures
Connecting to Network Printers
Viewing the Entire Network Queue



Keyboard: Bypassing Print Manager
To bypass Print Manager:
1 Open the Print Manager window.
2 Press ALT and then O.
3 Press N.
4 Press ALT+P.
5 Press the SPACEBAR to select the Print Net Jobs Direct option.
6 Press ENTER.

Related Procedure
Mouse Procedure





To move Press

A selected file up in a local print queue CTRL+UP ARROW

A    selected file down in a local print 
queue

CTRL+DOWN 
ARROW





Print Manager
Handles print requests for your printer. Whenever you print a document from a Windows application, the 
application passes all the printer and font information about the file to Print Manager. Print Manager 
handles the request in the background while you continue working.



application Control-menu



title bar          
Contains the title of the application running in the window, in this case Print Manager.

Drag the title bar to move the window.



Minimize button          
Click the Minimize button to shrink the Print Manager window to an icon.



Maximize button          
Click the Maximize button to enlarge the Print Manager window to its maximum size.



Options menu



View menu



Help menu



menu bar          
Contains the names of all the Print Manager menus.

Click a menu name to display commands.



Pause button          

Interrupts printing. Your ability to interrupt a network queue depends on the specific features the network
supports.

Click the Pause button to interrupt printing temporarily.



Resume button          

Resumes printing.
Click the Resume button to continue printing.



Delete button          

Deletes a file from the print queue. You may not be able to delete a file from a network print queue if 
your network software does not support this feature.

Click the Delete button to remove a file from the print queue.



message box          

Shows you details about the active printer including the name of the printer, its location (local or 
network), its port, and its printing status.



local printer information line          

Displays details about a local printer: the name of the printer, its port, and its current status.



local file information line          

Displays details about the documents in a local print queue.
Select a file information line to perform some operation on it, such as pause printing, resume 

printing, or cancel the print job.



network printer information line          

Displays details about a network printer: the name of the printer, its network location, and its current 
status.



network file information line          

Displays details about the documents in a network print queue.
Select a file information line to perform some operation on it, such as pause printing, resume 

printing, or cancel the print job.



application window
The main window for an application, in this case the Print Manager window. The Print Manager 
application window lets you view important information about printer activity and lets you control items in
the queue.



window border          
The outside edge of a window.

Drag the window border to change the size of the window.







A
386 enhanced mode
active
active printer
animation
application
application icon
application window
arrow keys
associate
AUTOEXEC.BAT



B
<< button
>> button
Back button
base-level synthesizer
batch file
baud rate
bitmap
branch
browse
byte



C
cascading menu complementary color
CD-ROM compound device
channel CONFIG.SYS
check box Contents button
choose Control menu
Clipboard Control-menu box
close conventional memory
collapse cutout
command
command button
command line



D
data bits Directory Tree window
default button directory window
default printer disk-drive icon
desktop display box
desktop pattern document
destination directory document file
device contention document window
device driver DOS
dialog box drag
directory path drop-down list box
Directory Tree



E
error-checking
expand
expanded memory
extended memory
extended synthesizer
extension



F
file
file information line
flow control
font
font size
format
full-screen application



G
General MIDI Mode standard
group
group icon
group window



H
History button
hotspot
hue
HyperGuide button bar



I
icon
insertion point
International MIDI Association



J
No defined terms.



K
keymaps
keyword
kilobyte



L
list box
local printer
local queue
luminosity



M
maximize MIDI Mapper
Maximize button MIDI sequencer
Media Control Interface MIDI Manufacturer's Association (MMA)
memory minimize
menu Minimize button
menu bar movie file
menu command MSCDEX
menu name multimedia extensions
menu title Multimedia PC
MIDI multitasking
MIDI file



N
network printer
network queue
network server
non-Windows application



O
open
option button



P
parity print option
palette printer-driver file
patch printer font
patchmaps printer queue information line
pathname program file
picture elements program information file (PIF)
pixels program item
playlist program item icon
pointer
port



Q
No defined terms.



R
RGB components
read-only
real mode
Restore button
root directory



S
sample serial port
saturation shortcut key
scaled font size shrink
screen font simple device
screen saver solid color
scroll arrow source directory
scroll bar spin box
scroll box standard mode
Search button status bar
select stop bits
selection cursor synthesizer



T
Task List
text box
text file
title
title bar
topic
track



U
Up button



V
vector font
virtual memory
volume label



W
waveform
WAVE format
wildcard characters
window
window border
Windows application
wrap



X
No defined terms.



Y
No defined terms.



Z
No defined terms.



386 enhanced mode
Provides access to the virtual memory capabilities of the Intel 80386 processor. With virtual memory 
capabilities, Windows applications can use more memory than is physically available. Enhanced mode 
also allows for multitasking of non-Windows applications.



active
Describes the selected window or icon that you are currently working with. Windows always applies the 
next keystroke or command you choose to the active window. If a window is active, it appears in front of 
all other windows on the desktop, and its title bar changes color to differentiate it visually from other 
windows. If an icon is made active, its Control menu appears.
Inactive is the opposite of active and describes windows or icons on the desktop that are not selected.



active printer
An installed printer that has been assigned to a printer port using Setup or Control Panel. More than one
printer can be set up to work on a single port, but only one can be active, since only one printer can be 
physically connected to the port at a time.
An inactive printer is an installed printer that is not currently connected to the printer port.



animation
The display of a series of graphic images, simulating motion. You can play animation files (for example, 
files with the.MMM extension) with the Media Player accessory. Animations are also called movies.



application
A computer program used for a particular kind of work, such as word processing. This term is often used
interchangeably with "program."



application icon          

An icon that represents an application that is running.



application window
The main window for an application. It contains the application's menu bar and main workspace. An 
application window may contain multiple document windows.



arrow keys          

The four arrow keys on your computer keyboard. These keys move the cursor or pointer on your screen 
to locations you choose. Each arrow key moves the cursor or pointer in the direction of the arrow on the 
key. Each arrow key is named for the direction in which arrow points: UP ARROW, DOWN ARROW, LEFT 
ARROW, and RIGHT ARROW.



associate
To assign files that have the same extension to a program. When you choose a file with the specified 
extension, the associated application runs with the file loaded.



AUTOEXEC.BAT
Batch file that lists MS-DOS commands. MS-DOS automatically carries out the commands in your 
AUTOEXEC.BAT file when you turn on your computer. The file is located in the root directory of your first
hard disk, which is usually drive C.
Typically, an AUTOEXEC.BAT file starts memory-resident utilities such as a network and sets up 
environment variables that are used later by applications. In addition, your AUTOEXEC.BAT file might 
set your MS-DOS prompt or start pop-up programs such as Borland's SideKick.



<< button          

Displays the previous topic in a series of topics, until you reach the first topic in the series. Then the 
button is dimmed. Use this button when you want to backtrack through topics the way they are 
organized in HyperGuide.



>> button          

Displays the next topic in a series of topics, until you reach the last topic in the series. Then the button is
dimmed. Use this button to move from topic to topic in the recommended order.



Back button          

Displays the last topic you viewed. HyperGuide moves back one topic at a time, in the order in which 
you viewed them.



base-level synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



batch file
A file that runs a sequence, or "batch," of commands when you type its filename. All filenames of batch 
files end with the extension .BAT, even though you don't have to type this extension to run the batch file.



baud rate
Signalling speed measured by the number of signals per second.



bitmap          

An image stored as an array of bits.



branch          

A segment of the Directory Tree, representing a directory and any subdirectories it contains.



browse
To look through files and directories. In some dialog boxes, the Browse button shows a list of files and 
directories from which you can choose.



byte
The amount of memory space (normally 8 bits) that a computer needs to represent a single character or 
word.



cascading menu          

A menu that opens from a command on another menu.



CD-ROM
Compact Disc-Read Only Memory. An optical data-storage technology that allows large quantities of 
data (such as animations, images, music, and sound) to be stored on a compact disc similar to discs 
used by the music industry.



channel
MIDI uses channels to send messages to individual devices within a MIDI setup. There are 16 MIDI 
channel numbers. Devices in a MIDI setup can be directed to respond only to messages marked with a 
channel number specific to the device.



check box           

A small square box that appears in dialog boxes and can be selected or cleared. When the check box is 
selected, an X appears in the box.



choose
To use key combinations or your mouse to carry out a command in Windows. You often choose a 
command after you have selected an item or made it active.



Clipboard          

A temporary storage area in memory, used to transfer information. You can cut or copy information onto 
the Clipboard and then paste it into another document or application.



close
To reduce a document window or application window to an icon or, in some cases, to remove it from the 
desktop. You close a window by double-clicking the Control-menu box or choosing the Close command 
from the Control menu. When closing an application window, you can choose to save or abandon 
changes to the current document before you close it.



collapse
To hide a level of directory information in the Directory Tree window. When you first start File Manager, 
all directories but the root directory are collapsed.



command          

A word or phrase, usually found in a menu, that you choose to carry out an action.



command button          

A button in a dialog box that carries out or cancels the selected action. Two common command buttons 
are OK and Cancel. The button that carries out the action will often have a label that describes it (for 
example, Open, Create, Install). Another dialog box appears when you choose a command followed by 
ellipses.



command line
Information given to MS-DOS that specifies a command and all the pertinent information to carry it out. 
For example, to start Windows, you type win at the MS-DOS prompt.



complementary color
The color exactly opposite a color on the RGB color wheel. For example, the complementary color of 
blue is yellow.



compound device
Devices, such as the waveform audio driver, that have an associated file and require a filename 
specification when opened.



CONFIG.SYS
A file that defines device drivers and specifies your MS-DOS configuration. For example, a typical 
CONFIG.SYS file might specify the location of the MS-DOS file COMMAND.COM, define an extended 
memory manager, and specify how many files an application can have open at once. MS-DOS runs the 
commands in the CONFIG.SYS file each time you turn on your computer. Your CONFIG.SYS file is 
located in the root directory of your first hard disk, which is usually drive C.



Contents button          

Displays the HyperGuide contents.



Control menu          

The menu in the upper-left corner of a window. The Control menu appears on every application that runs
in a window and on some non-Windows applications. Document windows, icons, and some dialog boxes
also have Control menus.
Control menu commands move, change the size of, and close windows. You can also switch to Task List
by using the Control menu. For non-Windows applications, Control menu commands transfer 
information and perform other functions, depending on the application.



Control-menu box
The box located in the upper-left corner of a window. Clicking the Control-menu box opens the Control 
menu for the window.



conventional memory
The first 640K of memory that MS-DOS uses to run applications. Most computers have at least 256K of 
conventional memory and can accommodate up to 640K of conventional memory.



cutout          
A portion of a Paintbrush drawing you select with the Scissors or Pick tool.



data bits
The bits in each package of data sent between two computers during telecommunication. Most 
characters are transmitted in 7 or 8 data bits.



default button          

The command button in some dialog boxes that is automatically selected or chosen by Windows as the 
most logical or safest choice. The default button has a bold border, indicating that it will be chosen if you 
press ENTER. You can override a default button by choosing Cancel or another command button.



default printer
The printer that Windows applications automatically use when you choose the Print command. You can 
have only one default printer, which must also be the active printer on the port. The printer you use most 
often should be made the default printer.



desktop
The background of your screen, on which windows, icons, and dialog boxes appear.



desktop pattern
A geometric pattern that appears across your desktop. You can design your own pattern or choose one 
of the patterns provided by Windows.



destination directory
The directory to which you intend to copy or move one or more files.



device contention
When several applications simultaneously request use of a peripheral device, such as a printer or 
modem.
Windows automatically handles device contention when all the applications are Windows applications. 
When one of the applications is a non-Windows application, however, the conflict is handled according 
to the options you select in the 386 Enhanced dialog box. This dialog box appears when you choose the 
386 Enhanced icon in Control Panel.



device driver
Tells Windows how to control a piece of hardware. Using Control Panel, you can install device drivers for
your:

Display (monitor)
Keyboard
Mouse
Network



dialog box          

A rectangular box that either requests or provides information. Many dialog boxes present options that 
you must choose from before Windows can carry out a command. Some dialog boxes present warnings 
or explain why a command can't be completed.



directory path          

The directions to a directory or file within your system.
In the illustration, C:\ART stands for the ART directory on drive C. Any commands you use affect the files
and subdirectories in this directory.
When you want to specify a file, make sure the filename follows the directory path.



Directory Tree          

A graphic display of a disk's directory structure. The directories on the disk are shown as branching from
the disk's root directory.



Directory Tree window          

A File Manager window that shows the complete branching structure of the selected disk drive.



directory window          

A File Manager window that lists the contents of a specific directory. The directory window shows all the 
files and subdirectories contained in the directory.



disk-drive icon          

An icon in the Directory Tree window of File Manager that represents a disk drive on your system. 
Different icons depict floppy disk drives, hard disk drives, RAM drives, CD-ROM drives, and network disk
drives.



display box          

A display box is not an option, but a type of text box that shows an example of another option you have 
selected, in this case a sample of the 10 pt, underlined, Helvetica font.



document
Whatever you create with an application, including information you enter, edit, view, or save. A document
can be a business report, a spreadsheet, a picture, and so on.



document file          

Files that are associated with an application. You can start an application and open the associated file by
choosing a document file icon.



document window          

A window inside an application window. Each document window contains a single document or other 
data file. There can be more than one document window inside an application window.



DOS
Disk Operating System, typically known as MS-DOS (Microsoft) or PC-DOS (IBM). This is the underlying
software that must exist for your PC to operate.



drag
A mouse move. You drag a Windows element by pointing to it, holding down the mouse button, and 
sliding the mouse from one spot on the surface of your desk to another and releasing the mouse button.



drop-down list box
A list box that opens and closes in dialog boxes.
Before you open a drop-down list box, it looks like this:

After the list box is open, it looks like this:

NOTE: When the list is longer than the box, scroll bars are provided.



error checking
A method for validating transmissions.



expand
To show hidden directory levels in the Directory Tree. With File Manager, you can expand a single 
directory level, one branch of the Directory Tree, or all branches at once.



expanded memory
Memory in addition to conventional memory that is available to applications. It is allocated in 16K blocks.
Windows makes use of expanded memory only if the /r switch is used at startup. Windows running in 
386 enhanced mode simulates expanded memory for the applications that need it. Windows running in 
standard mode or 386 enhanced mode allows applications to use expanded memory, but does not use 
expanded memory itself in managing applications.



extended memory
Memory in addition to conventional memory that is not readily accessible to MS-DOS or MS-DOS 
applications. Extended memory cannot be used on 8086 and 8088 computers. Windows running in 
standard mode or 386 enhanced mode uses extended memory to manage and run applications.



extended synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



extension
Part of a file or directory name that appears after a period and provides additional information. It usually 
indicates the type of file or directory. For example, program files have default extensions of .COM 
or .EXE .
Many applications include a default extension automatically when you save a file the first time. For 
example, Notepad adds a .TXT extension to all filenames unless you specify otherwise.



file
A document or application that has been given a name. All documents are stored as files in Wiindows.



file information line          

Information specific to each file in a print queue. The information can include these details:
The file's position in the queue or a printer icon if the file is printing.
The title of the print job assigned by the application (if your network software supports this).
What percentage of the file has printed so far.
The size of the file in kilobytes (if the Print File Size command on the View menu is selected).
The time and date you sent the file to Print Manager (if the Time/Date Sent command on the View

menu is selected).
If you are connected to a network printer, the printer queue information line shows the network server 
connection. Any detailed information the network can provide appears in the message box at the upper-
right corner of the Print Manager window. Networks can provide varying degrees of detailed information.



flow control
The method for controlling the flow of information.



font          
A graphic design applied to all numerals, symbols, and characters in the alphabet. A font usually comes 
in different sizes and provides different styles, such as bold, italic, and underlining for emphasizing text.



font size
The height of a printed character, measured in points. One inch equals 72 points. For example, 12-point 
Helv is 12 points high.

The font and font size you use determine the amount of text that fits on one page. 



format
(1) The appearance of text on the pages of a document. (2) To prepare a disk so it can hold information. 
Formatting a disk erases all information that was previously on it.



full-screen application
A non-Windows application that uses the entire screen--rather than a window--to run in the Windows 
environment.



General MIDI Mode standard
A MIDI specification controlled by the MIDI Manufacturers Association (MMA). The purpose of this 
specification is to enable MIDI file authors to create files that sound the same across a variety of 
different synthesizers.



group
A collection of applications within Program Manager. Grouping your applications makes them easier to 
find.



group icon          

A group window you have reduced to an icon in Program Manager.



group window          

A window that displays the items in a group within Program Manager. These items can be applications, 
files associated with applications, or a combination of both.



History button        

Displays a list of the HyperGuide topics you have viewed. Use this button to revisit any of the last 40 
HyperGuide topics you have viewed. The most recent topic appears first.



hotspot
Text, graphics, or parts of graphics that provide links to other HyperGuide topics or more information 
about the current topic.
Whether text or graphics, the pointer changes to the shape of a hand whenever it is over a hotspot. If 
you click a hotspot that is linked to another topic, that topic will appear in the HyperGuide window. If the 
hotspot is linked to more information, HyperGuide displays the information in a popup window on top of 
the HyperGuide window.



hue
The position of a color along the color spectrum.



HyperGuide button bar          
Contains the HyperGuide buttons you use to move among topics and contents screens. It is located 
near the top of the HyperGuide window.



icon          

A graphic representation of a disk drive, directory, group, application, document, and so on. You can 
restore an application icon to a window when you want to use the application.



insertion point          
The place where text will be inserted when you type.The insertion point usually appears as a flashing 
vertical bar in an application's window or in a dialog box. The text you type appears to the left of the 
insertion point, which moves to the right as you type.



International MIDI Association (IMA)
The non-profit MIDI organization that circulates information about the MIDI specification.



keymaps
Percussion instruments are key-based--each note plays a different percussion instrument. Keymaps 
translate MIDI key values to ensure the proper percussion instruments are used to play MIDI files. All 
MIDI files for Windows are authored using standard key assignments based on the General MIDI Mode 
standard.



keyword
Words in the HyperGuide Search dialog box that are associated with topics. Each application's 
documentation has its own keyword list, including the glossary words in HyperGuide. You select from the
list of keywords or type a keyword to see the list of topics associated with that keyword.



kilobyte
The measurement used for the size of a computer's memory, where 1 kilobyte (K) = 1,024 bytes.



list box          

A box within a dialog box that lists available choices--for example, the list of all available files in a 
directory. If all the choices don't fit in the box, there will be a vertical scroll bar to the right of the list box. 
In some list boxes, you can select more than one item.



local printer
A printer that is directly connected to your printer by a cable.



local queue          

Lists the files that you directed to any active printer connected to your computer. The computer and 
printers are connected locally by a cable.
When Print Manager starts printing on a local printer, its icon appears at the bottom of your screen. If 
you restore the icon to a window, you see the print queue for any active printer connected to your 
computer. You can use the Print Manager window to check the status of files in the print queue or to 
interrupt or cancel a print job.



luminosity
The brightness of the color on a scale from black to white.



maximize
To enlarge a window to its maximum size by using the Maximize button or the Maximize command.



Maximize button          

The small button at the upper-right corner of a window that contains an Up arrow. Mouse users can click
the Maximize button to enlarge a window to its maximum size. Keyboard users can use the Maximize 
command on the Control menu.



Media Control Interface (MCI)
A standard control interface for multimedia devices and files. MCI allows a multimedia application to 
easily control a variety of multimedia devices and files.



memory
The space in a computer where information is stored while you are working with it. Most PCs have a 
small amount of read-only memory (ROM), containing the built-in programs that start the operation of 
the computer when it is turned on, and a large amount of random-access memory (RAM) for users' 
programs and data.



menu          

A list of available commands in an application window. Menu names appear in the menu bar near the 
top of the window. The Control menu, represented by the Control-menu box at the left end of the title 
bar, is common to all Windows applications. You use a command on a menu by selecting the menu 
name, then choosing the command you want.



menu bar          
The horizontal bar containing the names of an application's menus. It appears just under the title bar.



menu command          

A word or phrase in a menu that you choose to carry out an action, such as copying a file.



menu name
The name for a particular menu that appears in the menu bar and opens a menu when you choose it.



menu title
A word or phrase in the menu bar that identifies a group of commands. Selecting the menu title causes 
the title to be highlighted and its menu of commands to appear below it.



MIDI
Musical Instrument Digital Interface. MIDI sets a communications standard for transferring data between
musical instruments and associated devices.



MIDI file
A file format for storing MIDI songs. In Windows, MIDI files have a .MID filename extension. 



MIDI Mapper
A Control Panel option that lets you create and edit MIDI setup maps. Windows uses these maps to 
translate and redirect MIDI data. 



MIDI Sequencer
Software that creates or plays songs stored as MIDI files. When a sequencer plays MIDI files, it sends 
MIDI data from the file to a MIDI synthesizer that produces the sounds. Windows provides a MIDI 
sequencer to play MIDI files.



MIDI Manufacturer's Association (MMA)
A collective organization composed of MIDI instrument manufacturers and MIDI software companies. 
The MMA works with the MIDI Standards Committee to maintain the MIDI specification. 



minimize
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



Minimize button          

The small button at the upper-right corner of a window that contains a Down arrow. Mouse users can 
click the Minimize button to reduce a window to an icon. Keyboard users can use the Minimize 
command on the Control menu.



movie file
A multimedia data file (for example, a file with the .MMM extension). You can play movie files with the 
Media Player accessory. Movie files are also called animations. 



MSCDEX
Microsoft Compact Disc Extensions. MSCDEX is software that makes CD-ROM drives appear to DOS 
as network drives. You must have MSCDEX installed on your computer for the CD-ROM drive to work. 



multimedia extensions
Additional features added to Windows version 3.0 that enable your computer to run animations, play 
sound and MIDI files, and display high-quality images. 



Multimedia PC
Multimedia personal computer. A multimedia computer satisfies a minimum set of hardware/software 
requirements necessary for multimedia computing. The requirements include:

An 80286/386/486 microprocessor running at 10MHz or faster
2MB or more of RAM
30MB or larger hard disk
VGA display
A digital audio subsystem
A CD-ROM drive
Systems software compatible with Microsoft Windows version 3.0 with multimedia extensions



multitasking
The ability of a single computer to perform several tasks simultaneously.
Multitasking makes it possible to print one document while editing another, or to perform lengthy 
computations while you work on something else.



network printer
A printer that is accessible to your computer only through a network.



network queue
Lists the files on the network server if you are using a network printer.



network server
A computer on a network that provides a particular service to other computers. For example, a disk 
server manages a large file server, and a print server manages a printer.



non-Windows application
An application that was not designed to run in Windows. Generally, non-Windows applications do not 
conform to Windows user-interface standards.



open
To display the contents of a directory or file in a window, or to enlarge an icon to a window.



option button           

A small round button that appears in a dialog box and is used to select an option. Within a group of 
related option buttons, you can select only one button.



palette
Defines the colors used in a bitmap image. Every device independent bitmap (DIB) has an associated 
color palette. 



parity
The method of detecting errors in data transmission.



patch
A specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as patches.



patchmaps
A patch is a specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as 
patches. Patchmaps translate MIDI patch changes to ensure the proper instruments are used to play 
MIDI files. All MIDI files for Windows are authored using standard patch assignments based on the 
General MIDI Mode standard.



pathname
The directions to a directory or file within your system. For example, C:\WINDOWS3\APPTS\JUNE.CAL 
is the pathname of the JUNE.CAL file in the APPTS subdirectory in the WINDOWS3 directory on drive 
C.



picture elements
The smallest graphics unit on the screen. Also known as pels.



pixels
The smallest graphic units on the screen. Also known as picture elements (pels).



playlist
A list of compact disc titles and tracks that determines the order in which the tracks on the disc are 
played. Playlists are only used in Music Box.
Use the Program button to assign or edit titles, and to change the playlist.



pointer          
In Windows, the shape of the pointer indicates its function.

For selecting Windows items, scrolling, resizing windows, 
and moving windows and dialog boxes with your mouse. 
This is the pointer you will see most often.

For choosing a HyperGuide hotspot.

For selecting text with your mouse.

For changing the size of a window with your mouse.

For changing the location or size of a window with your 
keyboard.

For indicating the application is processing your request.

port
A connection on a computer where you plug in a cable that carries data to a device.
LPT ports are parallel ports. COM ports are serial ports. EPT is a port used for certain printers, such as 
the IBM Personal Pageprinter. You can use the EPT port only if you have installed a special card in your 
computer.
Multimedia PCs also have a port for a MIDI sequencer.



print options
Printer-specific settings such as page orientation--portrait or landscape--or the manner in which paper 
feeds through the printer. These options vary from printer to printer.



printer-driver file
A file that gives Windows important information about how to control your printer, including details about 
printer features and the printing interface, descriptions of fonts (such as sizes and styles), character 
translations, and control sequences the printer uses to achieve various formats. Windows has printer-
driver files for most commonly used printers.



printer font
A series of dots connected by lines that can be scaled to different sizes. Another name for printer fonts is
vector (or stroke) fonts. Plotters typically use vector fonts.



printer queue information line          

Indicates the following:
The name of the printer.
Where the printer connects to your computer.
The current status of the printer.



program file          

A file that contains information that controls an application. In File Manager, each program file is 
represented by an icon. You can start the application by choosing the icon. Filenames for program files 
can have these extensions: .EXE, .COM, .PIF, and .BAT.



program information file (PIF)
A file that provides important information that Windows needs to run a non-Windows application. PIFs 
contain information such as the name of the file, a startup directory, whether the program writes directly 
to the screen or to memory, and multitasking options for applications running in 386 enhanced mode.



program item          

A program file or associated document represented by an icon in Program Manager. The program item 
provides the instructions Windows needs to start an application and open a document (if specified) when
you choose the icon.



program item icon          

An icon representing an application you can start or an associated document you can open from a group
in Program Manager. The program item provides the instructions Windows needs to start an application 
and open a document (if specified) when you choose the icon.



RGB components
The amount of each of the three primary colors--red, green, and blue--present in a color. Every color and
pattern is made by varying the three primary colors. This is true even in monochrome (black and white) 
mode. For instance, white is made by mixing together 255 parts of red, 255 parts of green, and 255 
parts of blue. Black, on the other hand, is 0 red, 0 green, and 0 blue.



read-only
Describes a file or CD-ROM disc that can only be opened and read. You cannot edit a read-only file or 
CD-ROM disc and save your changes.



real mode
An operating mode that Windows runs in to provide maximum compatibility with versions of Windows 
applications released prior to Windows version 3.0. Real mode is the only mode available for computers 
with less than 1 MB of extended memory.



Restore button          

The small button at the upper-right corner of a window that contains both an Up arrow and a Down 
arrow. The Restore button appears only after you have enlarged a window to its maximum size. Mouse 
users can click the Restore button to return the window to its previous size. Keyboard users can use the 
Restore command on the Control menu.



root directory
The main directory on a disk. The root directory is created at the first level when you format a disk. The 
symbol used to indicate the root directory of a disk is the backslash (\). For example, the root directory 
for drive C is noted as C:\.



sample
A piece of waveform data represented by a single numerical value. You convert sound into digital form 
by taking samples of the sound at specific time intervals and converting them to numeric values.



saturation
The purity of a hue, moving from gray to the pure color.



scaled font size
A font size that approximates a specified font size for use on the screen. Windows scales larger font 
sizes when a size that is available for the printer is not available for the screen. Scaled fonts may look 
slightly different from unscaled fonts. When you choose a smaller font size that is available for the printer
but not for the screen, Windows substitutes the correct size from a precision-drawn font that resembles 
the selected font as closely as possible.



screen font
A font that duplicates a printer font on your screen.

If you choose a printer font that does not have a corresponding screen font, Windows substitutes a 
screen font that closely resembles the printer font. The substitute font duplicates the line lengths and 
page breaks of the font you selected.
When you purchase extra fonts from a printer or font manufacturer, ask about the availability of screen 
fonts to match.



screen saver
An image or pattern that is shown on your computer screen during periods of inactivity. Screen savers 
hide information currently on the screen; by changing patterns they can also save wear on the 
electronics in the display.



scroll arrow          

An arrow on either end of a scroll bar that is used to scroll through the contents of a window or list box. 
Clicking a scroll arrow moves the contents one line. Holding down a scroll arrow scrolls the contents 
continuously.
Scroll arrows also control the playing of media in some applications, such as Media Player and Sound 
Recorder.



scroll bar          
A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box, which allow you to scroll within the window or
list box.
A scroll bar is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



scroll box          

The square or rectangular box within a scroll bar that indicates your relative position within a document 
or list box. Mouse users can drag the scroll box up or down quickly through long documents.
A scroll box is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



Search button          

Displays the keywords you can use to search for topics. Use this button to look for topics related to a 
keyword.



select
To mark an item by highlighting it with key combinations or with a mouse. Selecting does not initiate an 
action. After selecting an item, you choose the action that affects or involves the item. For example, you 
can select text and then choose the Copy command to copy the text onto the Clipboard.



selection cursor          
The marking device that shows where you are in a window, menu, or dialog box and what you have 
selected. The selection cursor appears as a dotted box around the text in a dialog box option.



serial ports
Ports used by your system, named COM1, COM2, and so on. Serial ports are typically used for 
connecting modems, mouse devices, and some kinds of printers.



shortcut key          

A key or key combination, available for some commands, that you can press to carry out a command 
without first selecting a menu. The shortcut key for a command is listed to the right of the command 
name on the menu.



shrink
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



simple device
Devices, such as audio compact-disc players, that don't have an associated file and can be opened 
without a filename specification.



solid color
A color directly supported by your display.



source directory
The directory containing the file or files you intend to copy or move.



spin box          

A spin box shows one item in a range of possible choices. Clicking the Up or Down arrow to the right of 
the entry lets you "spin" through the available choices until your choice appears in the display rectangle.



standard mode
The normal operating mode for running Windows. This mode provides access to extended memory. In 
standard mode, you can also switch among non-Windows applications.



status bar          
A line of information located at the top or bottom of a window. For example, in a directory window the 
status bar tells how many files are selected, how much disk space they occupy, and the total number of 
files in the directory. In the Directory Tree window, the status bar shows the number of bytes available on
the disk and the total disk capacity. Not all windows have a status bar.



stop bits
The timing unit between characters.
Stop bits are not actually bits; they determine the time between transmitted characters.



synthesizer
An electronic instrument able to make music and sounds by creating its own audio waveforms and 
sending them out to an audio system. A synthesizer can play back MIDI files.



Task List
A window that shows all the applications you have running so you can switch among them. You can 
open the Task List window by choosing Switch To from the Control Menu or by pressing CTRL+ESC.



text box          

A box within a dialog box where you type the information needed to carry out a command. When the 
dialog box appears, the text box may be blank or may contain text.



text file
A file containing only plain text, numbers or symbols. The text in a text file is uniform and does not 
contain any formatting, such as bold, underline, or different fonts and font sizes. A text file usually 
consists of characters coded from the ASCII character set. 
The advantage of a text file is that it can be transferred to almost any text editor or word processor. Also,
MS-DOS and Windows use text files, such as AUTOEXEC.BAT, CONFIG.SYS, and WIN.INI.



title
Another name for a software application written to run on a Multimedia PC. 



title bar          
The horizontal bar at the top of a window that contains the title of the window or dialog box. On many 
windows, the title bar also contains the Control-menu box and Maximize and Minimize buttons.



topic
The level in the HyperGuide hierarchy at which you see information in the main window. This information
can be in the form of a Quick Look graphic, an explanation of a command, a conceptual overview, a 
procedure, or a table of keys. Information in pop-up windows and contents screens are not considered 
topics.



track
A sequence of sound on a CD disc, which usually corresponds to a song.



Up button          

Moves up one level in the HyperGuide hierarchy.



vector fonts
A series of dots connected by lines that can be scaled to different sizes.



virtual memory
A memory management system used by Windows running in 386 enhanced mode, which allows 
Windows to behave as if there were more memory than is actually present in the sytem. Virtual memory 
equals the amount of free RAM plus the amount of disk space allocated to a swap file that Windows 
uses to simulate additional RAM.



volume label          
The name you give a disk by using the Label command. Disk labels are optional. You see this 
information in File Manager only if you assigned a label to your disk. You can change or add a disk label 
through File Manager.



WAVE format
Microsoft's format for digitized waveform files. These files have a .WAV extension.



waveform
A sound waveform displays variances in air pressure over time. An audio signal waveform displays 
variances in voltage over time.



wildcard characters
Two MS-DOS characters you can substitute for all or part of a file or directory name when you want to 
find similarly-named files or want one command to affect a number of files or directories.
An asterisk (*) substitutes for all characters. A question mark (?) substitutes for a single character.
For example, this entry covers all files with a .DOC extension in the current directory:

*.DOC
And this entry covers everything named with FY, three other characters, and the extension .90:

FY???.90



window
A rectangular area on your screen in which you view an application or document. You can open, close, 
and move windows, and change the size of most windows. You can open several windows on the 
desktop at the same time and you can shrink windows to icons or enlarge them to fill the entire desktop.



window border          
The outside edge of a window. You can lengthen or shorten each border. You can also change the width 
of the border with Control Panel's Desktop command.



Windows application
An application that was designed for Windows and will not run without Windows. All Windows 
applications follow the same conventions for arrangement of menus, style of dialog boxes, use of the 
keyboard and mouse, and so on.



wrap
The automatic movement of the insertion point from the end of one line to the beginning of the next line 
as you type. When text wraps, you do not need to press ENTER at the end of each line in a paragraph.






